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MYPEM

Maintaining payroll information using 
EXO Payroll
This training manual has been 

developed by the MYOB Enterprise 

Division team for use in the delivery of 

training.

This manual uses a simple step-by-

step approach to give you the skills 

and knowledge necessary to maintain 

payroll information process pays using 

EXO Payroll.

This manual has been designed for the 

following MYOB product:

• EXO Payroll

Course duration: 1.5 hrs.
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Participants
This course is aimed at:

• Users of EXO Payroll.

Prerequisites
Basic PC experience is required.

Understanding of payroll processes and procedures.

Instructional method
The instructional method uses examples of system configuration. Each unit concludes with a 
Review Task. 

Conventions used in this manual
• Objects such as buttons or icons that you must click or select are shown in bold.

• Information to be entered (typed in) or selected is shown in bold and italics.

• Keyboard keys are shown as , , etc.

Screenshots in this manual are for illustration purposes only and may differ from those in the actual 
product due to configuration settings.
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Symbols used in this manual

Symbol Name This symbol tells you... 

Practice task

Review task

… to complete a task to practice the skills 
you have just learnt, or as a review task at the 
end of the unit to consolidate what you have 
learnt.

Written Review task … to complete written questions to review 
the content covered in the unit.

Optional Challenge … to complete this task if you have finished 
early and are looking for an extra challenge.

Tip … about helpful tips.

Note … to take note of an important message.

Warning … about potential problems to be aware of.

Important … to pay attention to an important notice.

New … where features are new for EXO Payroll

Reference … where to go to find more information.

Skills Checklist … to tick off a list of skills that you have 
learnt during the unit.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Objectives

In this course you will learn how to maintain your EXO Payroll system.

Upon completion of this course you will be able to:

• Set up cost Centres

• Set up Allowances

• Set up Deductions

• Set up Superannuation Funds and Contributions

• Set up Employees

• Load Year-To-Date earnings/balances

• Set up backups

• Make a system backup and restore from backups

• Process end of year

Before you begin:
This training manual has been designed for use with the Demonstration Company 
and assumes that you do not have any other MYOB Employer Services products, 
e.g EXO Time and Attendance.

1 From the Login screen, double-click on the Demonstration Company.

2 From the Utilities menu, click on Setup Exo Payroll.

3 From the list of setup areas, click on Other Setup.

4 Click on the Wages section.

5 Ensure that the options “Do not copy wages for Time and Attendance 
employees” and “Do not copy wages for Rapid employees” are not 
selected.

6 Click on the Save button or press F10.
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Function Keys

F1 Help

F2 Maintenance Menu

F3 Change Sort

F4 Add

F5 Edit

F6 Delete

F7 Previous

F8 Next

F9 Find/Print

F10 Save

F11 Abount Screen

F12 Employee Notes

Page Up/Page Down Switch between pages

Alpha/Numeric Keystrok Activates incremental search of picklists

Spacebar Opens combo boxes

Home Skips to start of field

End Skips to end of field

Tab Skips to next field

Shift+Tab Skips to previous field

Ctrl+H Activates the hide screen, which can be locked with the password 
you logged in with

Ctrl+D Activates the Diary. This is a form of daily planner, providing you 
with a place to enter comments on any given day for payroll 
company-related tasks, appointments and reminders. You can scroll 
through the calendar months with the left and right arrows buttons

Ctrl+L Activates the Calculator
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Registration
In this unit, you will learn 

how to register your 

product.
By the end of this unit, you will be able to:

Complete your product registration
y without permission from the publisher.
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Overview

Your MYOB product requires an annual registration for ongoing use of the 
product.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.



Unit 1—Registration
Three-month and Annual Registration

Three months after the software is installed and the initial registration is 
completed, the system is due for a three-month registration. This is a one-off 
registration that is only required for new products.

Annually on the installation date, the system is due for annual registration. This 
registration must be completed to continue using the system.

NOTE

An invoice for your Annual License Fee(s) will be issued one month prior to the due date. 
This invoice must be paid before any renewal codes will be issued by MYOB.

Submitting the Registration Form

Two weeks before the registration is due, the system will prompt for registration.

1 Click on the Register button.

2 The Registration Screen will be displayed. 

3 Click on the Change Details tab.

NOTE

It is important to check that your company contact details are correct before 
proceeding. We require this information to keep our customer database up to date.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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4 Make any necessary changes to your contact details.

5 Click on the Products tab.

6 In the grid, highlight the product due for registration.

7 The registration form can be faxed or e-mailed.

Updating the registration details

You will receive your renewal codes either via e-mail or fax.

NOTE

Due to the high volume of registrations due during our busy periods, it may take up to 
72 hours to process your registration.

1 From the Login screen, click on the Register button.

2 The Registration Screen will be displayed. 

To fax the registration form To e-mail the registration form

• Click on the Print button or Press 
F9. You will be prompted to 
preview the registration form 
before printing. Click on No.

• The Registration Form will be 
printed.

• Fax the Registration Form to: 
1800 004 587 (Australia), or 
0508 329 729 (New Zealand)

• Click on the Email button.

• A new e-mail message will be 
created using your e-mail 
application.

• Click on the Send button to send 
the e-mail.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.



Unit 1—Registration
3 Click on the Products tab.

4 In the grid, highlight the product due for registration.

5 Click on the Register button.

6 Enter the following details as they appear on the return fax/e-mail:

7 Click on the Save button or press F10.

8 A message will appear, confirming that the registration codes have been 
accepted.

The product is now registered for another 12 months.

Field Description

Type For your Three-Month Registration, change this to Live.

Renewal Year Enter the renewal year for your registration as provided.

Registration Code Enter the registration code as provided.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Submitting the Registration Form

Updating Registration details
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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User Security
In this unit, you will learn 

how to set up new Users 

and set security options.
By the end of this unit, you will be able to:

Set up a new User

Restrict User’s access
y without permission from the publisher.
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Overview

The system has a default Administrator user (User Code A) with full access to the 
system. The default password for the Administrator is Admin. Additional Users can 
be set up with restricted access.

It is recommended that each user that will access the system has their own User 
Code and Password for the following reasons:

1 Their access can be restricted

2 Users can set up reminders for themselves

3 For auditing purposes.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.



Unit 2—User Security
User Security

To set up a new User

1 From the Utilities menu, click on User Security.

2 In the User Code field, a login code for this user and press .

3 Enter the following information:

4 Ensure that the option Show Reminders when entering company is 
selected. This option will cause a screen to be displayed when you log into 
the company, listing all your reminders due.

Field Description

User Name Enter this user’s name.

Password

Enter a password for this user. If the password is left blank, it 
will default to myobabc.
Note: Passwords default to capitals and are limited to a 
maximum of 8 characters. Numbers should not be included in 
the password.

Default Application From the dropdown list, select the default product for this user.

E-mail Address Enter an e-mail address for this user
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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5 Click on the Access Rights tab.

6 From the Available list, select the areas the user should be able to access and 
move them to the Selected list. From the Selected list, select the areas the 
user should not access and move them to the Available area.

T I P

If you select the option View Only Access, the user will be able to access the areas 
listed in the Selected list, but only view information. They will be unable to make any 
changes to these areas.

7 Click on the Save button or press F10. The user is now added to the system.

I M P O R TA N T
It is not recommended that you delete Users that no longer access the system. For 
audit purposes, the system records changes made by users. If you delete the User from 
the system, the link to the user is broken.

To edit a User’s access

1 From the Utilities menu, click on User Security.

2 In the User Code field, enter the User Code of the User whose access you 
want to change. Alternatively you can click on the Find button or press F9 to 
get a list of Users set up in the system.

3 Click on the Access Rights tab.

4 Make the necessary changes to this user’s access rights.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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5 Click on the Save button or press F10. 
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Add a new User

Edit an existing User
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Hourly Rate 
Descriptions
In this unit you will learn 

how to change the default 

descriptions for Hourly 

Rates.
By the end of this unit, you will be able to:

Change the default description for Hourly 
Rates
y without permission from the publisher.
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Overview

Depending on your setup of EXO Payroll, you will be able to enter either one 
Hourly Rate per employee, or up to nine Hourly Rates per employee.

If your employees have multiple Hourly Rates, some rates may be related to specific 
tasks or be used under certain circumstances. To help you identify when to use 
each of these rates, you can change the default name for each of the Hourly Rates.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Unit 3—Hourly Rate Descriptions
Hourly Rate Descriptions

To change the Hourly Rate Description

1 From the Utilities menu select Setup Exo Payroll.

2 Click on the Payment Setup button and select the area Hourly rate.

3 Overwrite the default description for each of your Hourly Rates.

4 Click on Save or press F10.

5 These new descriptions will now be used in any screen that refers to these 
Hourly Rates.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Change default Hourly Rate descriptions
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Setting up Cost 
Centres
In this unit, you will learn 

how to set up Cost 

Centres.
By the end of this unit, you will be able to:

Define Cost Centre Structure

Define Cost Centre Structure Name

Set up Cost Centres
y without permission from the publisher.
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Overview

Cost Centres are used for costing purposes. By using the Costing Analysis, you can 
determine where you expenditure is.

Cost Centres also link to your General Ledger. Each Cost Centre is associated with a 
specific General Ledger.

Setting up Cost Centres in EXO Payroll consists of three steps:

1 Define your Cost Centre Structure

2 Define your Cost Centre Structure names

3 Create your Cost Centres based on your structure
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.

8



Unit 4—Setting up Cost Centres
Cost Centre Structure

The first step in creating Cost Centres is defining the Cost Centre Structure. This 
structure will determine the reporting available in the system as well as the link to 
your general ledger.

To define a cost centre structure

1 From the Utilities menu, select Setup Exo Payroll.

2 From the list, select the section Payment Setup.

3 Select the area Cost Centre Structure.

Cost Centres can be split into a maximum of four analysis levels. 

Example:

• States, e.g. NSW, VIC, etc.

• Each State is broken down into Departments, e.g. Sales, Marketing, etc.

• Each Department brown down into Expense Type, e.g. Wages, 
Superannuation, etc.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Each level is assigned a length, determining how many digits of the complete cost 
centre code represents each specific level. The maximum total Cost Centre Code 
length cannot exceed 12 digits.

Example:

• Level 1 (State) has a length of 1.

• Level 2 (Department) has a length of 1.

• Level 3 (Expense Type) has a length of 1. 

The total Cost Centre Code will be a length of 3 digits. The first digit would 
represent the State. The second would represent the Department and the third 
digit would represent the Expense Type.

4 In each of the analysis levels you wish to use, enter a description for that 
analysis level.

5 Enter a length for each analysis level.

I M P O R TA N T
In order to correctly cost and journal pay items to the appropriate general ledger 
account code, the option Mixed Proportional Costing must be selected at all times.

6 Click on the Save button or press F10.

Length Number range

1 1 - 9

2 1 - 99

3 1 - 999

4 1 - 9,999

5 1 - 99,999

6 1 - 999,999

7 1 - 9,999,999

8 1 - 99,999,999

9 1 - 999,999,999

10 1 - 9,999,999,999

11 1 - 99,999,999,999

12 1 - 999,999,999,999
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Unit 4—Setting up Cost Centres
Set up Cost Centre Structure Names

Before you can create any Cost Centres, you must define the structure names to be 
used for cost centres. 

To enter cost centre structure names

1 From the Maintenance menu, select Costing, followed by Cost Centre 
Structure Names.

For each analysis level, you must specify the names/descriptions available for that 
analysis level.

2 From the Analysis Type dropdown list, select the Analysis Level that you 
want to create.

3 In the Code field, enter the Code for that analysis item. 

NOTE

The analysis codes must match the length defined in the Cost Centre Structure setup 
in the Setup Exo Payroll area.

4 In the Name field, enter the name/description for this analysis code.

5 Click on Save or press F10.

6 Repeat Step 1 through 6 for all the analysis codes for each of your analysis 
levels.

7 Click on Exit or press ESC.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Setting up Cost Centres

To add a new Cost Centre

1 From the Maintenance menu, select Costing, followed by Cost Centres. 

2 In the Cost Center Code field, enter the complete Cost Centre code. Press 
.

3 The system will automatically generate the Cost Centre Name based on the 
Cost Centre Structure Names you have defined.

4 From the State dropdown list, select the State associated with this cost centre 
for Payroll Tax purposes.

5 In the General Ledger Code field, enter the General Ledger Code all 
transactions costed to this Cost Centre should be journalled to.

NOTE

If the General Ledger Code you want to use does not appear in the list, you can simply 
type it in and press . The system will prompt you to add it to the database. Click on 
Yes.

6 By default, the system can calculate your WorkCover levies on employees’ 
earnings liable for WorkCover. You have the option to calculate your 
WorkCover levy based on the Cost Centres to which the employees’ pay is 
allocated. By entering the rate at which the levy should be calculated in the 
WorkCover Levy Rate field, the system will calculate the levy at the specified 
percentage of the value costed to this cost centre.

7 Click on the Save button or press F10.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.

2



Unit 4—Setting up Cost Centres
To edit an existing Cost Centre

1 From the Maintenance menu, select Costing, followed by Cost Centres. 

2 In the Cost Centre Code field, enter a number of the cost centre you want to 
edit and press . Alternatively, you can click on the Find button or press F9 
to get a list of Cost Centres you have set up.

3 Make the required changes.

4 Click on the Save button or press F10.

NOTE

Once a Cost Centre has been used, it cannot be deleted.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Set up Cost Centre Structure Names

Set up a new Cost Centre

Edit an existing Cost Centre
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Allowances
In this unit you will learn 

how to set up new 

Allowances.
By the end of this unit, you will be able to:

Add Allowances

Edit exiting Allowances
y without permission from the publisher.
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Overview

Allowances are used to pay an employee additional items that are not classed as 
Wages/Salary or Leave, e.g. Bonusses, Reimbursements.

In this unit we will look:

• How to set up a new Allowance

• How to edit an existing Allowance
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Unit 5—Allowances
Adding new Allowances

To add a new Allowance

1 From the Maintenance menu, click on Allowances.

2 In the Allowance Code field, enter a number that you want to use to identify 
this Allowance. Press .

3 Enter the following information:

Field Description

Allowance Name Enter a name for the Allowance

Can Modify 
Name

If you select this option, you will be able to rename the Allowance 
when you use it.

PAYG Specify whether the Allowance is Taxable or Non-Taxable.

Calculation 
Method

From the dropdown list, select the calculation method the system 
should use to calculate the Allowance.

Amount
Enter the value of the Allowance.
Note: If the amount varies, leave this field as zero. If you enter an 
amount, you can’t change it when using it in a pay.

Rate
Enter the rate at which the Allowance is calculated.
Note: If the rate varies, leave this field as zero. If you enter a rate, 
you can’t change it when using it in a pay.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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4 From the Type dropdown list, select what type of Allowance this is:

5 If you want to cost this Allowance to a specific Cost Centre, enter the code in 
the Cost Centre field.

6 In the Maximum Number field, enter the maximum units of this Allowance 
the employee can be paid in each pay.

7 From the Payment Summary Allowance Type dropdown list, select the 
classification of this allowance for the PAYG Payment Summary. 

8 If the Calculation Method is set to Rated Units or Hourly Rate, you can also 
specify if leave should be accrued on this Allowance by selecting the option 
Include in Hours Paid.

Percentage
Enter the precentage at which the Allowance is calculated.
Note: If the percentage varies, leave this field as zero. If you enter a 
rate, you can’t change it when using it in a pay.

Pay Rate 
Multiplier

Select the Pay Rate at which the Allowance is paid.

Wage Rate Code Select the Hourly Rate Code at which this Allowance is paid.

Type Description

Reimbursement
Select this option for non-taxable reimbursements when 
paying the employee for expenses they incurred on behalf of 
the company.

Withholding 
Payment

Select this option if using the Allowance to pay the GST 
component to Contractors. Enter the Tax Rate in the 
Withholding Tax Rate field.

Back Pay
Select this option if using the Allowance to pay Back Pays. If 
the Back Pay should be taxed at a specific rate enter this rate 
in the Override Tax Rate field.

Bonus

Select this option if using this Allowance to pay regular 
bonusses. Leave the Periods to tax over field blank. This will 
allow you to change the number of period the bonus relates 
to when paying it.

One-Off / 
Irregular Bonus

Select this option if using this Allowance to pay one-off 
payments or irregular bonusses.

Normal Select this option for all other types of Allowances.
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9 Click on the Liabilities button.

10 Select the pay items this Allowance is liable for.

11 Click ont he Exit button.

12 Click on the Save button or press F10 to add this new Allowance.
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Editing an existing Allowance

1 From the Maintenance menu, click on Allowances.

2 Enter the Code of the Allowance you want to edit and press . 
Alternatively, you can click on the Find button or press F9 to get a list of 
existing Allowances.

3 Make the required changes.

4 Click on the Save button or press F10.

NOTE

You can also add the Allowance to a group of employees by clicking on the Load button. 
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.
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Deleting an existing Allowance

To delete an existing Allowance

1 From the Maintenance menu, click on Allowances.

2 Enter the Code of the Allowance you want to delete and press . 
Alternatively, you can click on the Find button or press F9 to get a list of 
existing Allowances.

3 Click on the Delete button or press F6. 

4 A message will appear, confirming that you want to delete this Allowance. 
Click on Yes.

I M P O R TA N T
If an Allowance is assigned to an employee, or was used in a pay, it cannot be deleted.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Set up a new Allowance

Edit an existing Allowance

Delete an Allowance
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Superannuation 
Contributions
In this unit, you will learn 

how to set up 

Superannuation 

Contributions.
By the end of this unit, you will be able to:

Set up Superannuation Providers

Set up Superannuation Guarantee 
contributions

Set up after-tax superannuation contributions

Set up salary sacrifice superannuation 
contributions
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Overview

The system can automatically calculate Employer Superannuation (SGC). Some of 
your employees may also elect to salary sacrifice part of their income to their 
Superannuation fund or make after-tax contributions.
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Superannuation Providers

Before setting up the Superannuation calculations, you must set up all your 
Superannuation Providers.

To set up Superannuation Providers

1 From the Maintenance menu, click on Superannuation Providers.

2 In the Provider Code field, enter the number you want to identify this 
provider with. Press .

3 Enter the following information:

Field Description

Provider Name Enter the name for the Superannuation Provider.

Account Enter the company’s account number for the 
provider.

BSB, Account Number Enter the banking details for the provider.

Address Enter the provider’s address details.

Phone Number Enter the provider’s phone number.

SPIN Enter the Superannuation Provider Identification 
Number.
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4 Click on the Save button or press F10.

5 If you did not enter the BSB and Account number, the system will display a 
reminder that you will not be able to pay contributions to this Provider 
electronically. Click Ok on this message.

To edit an existing Superannuation Provider

1 Enter the Code for the Provider you want to edit. Alternatively, you can click 
on the Find button or press F9 to get a list of providers.

2 Make the required changes.

3 Click on the Save button or press F10.

To delete a Superannuation Provider

1 Enter the Code for the Provider you want to delete. Alternatively, you can click 
on the Find button or press F9 to get a list of providers.

2 Click on the Delete button or press F6. 

3 A message will appear, confirming that you want to delete this 
Superannuation Provider. Click on Yes.

I M P O R TA N T
If this Superannuation Provider is assigned to a Superannuation calculation, it cannot be 
deleted from the system.

Sender ID Type From the dropdown list, select the appropriate 
ID type.

Sender ID Code Enter the ID Code used for this provider.

Employer 
membership #

Enter the company’s superannuation fund 
membership number.

Contact Name Enter the name of the contact person at the 
superannuation fund.

Provider Website Enter the superannuation fund’s website 
address.
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Employer Contributions (SGC)

To set up Employer Contribution (SGC) calculations

1 From the Maintanance menu, click on Superannuations.

2 A screen will appear that usually lists your existing Superannuation 
Calculations. Click on the Add button or press F4.

3 From the Superannuation Type dropdown list, select Employer 
Superannuation.

4 In the Code field, enter the number that you want to assign to this Employer 

Contribution. Press .

5 Enter the following information:

6 Select the option RESC if the contribution is a Reportable Employer 
Superannuation Contribution. Employer contributions you make for an 
employee are reportable where:

Field Description

Contribution Type From the dropdown list, select SG 
Contributions (Compulsary).

Calculation Method From the dropdown list, select how the 
superannuation contribution is calculated.
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• your employee influenced the rate or amount of superanuation you contribute 
for them

• the contributions are additional to the compulsory contribution you must 
make under any of the following:

•  superannuation guarantee law

•  an industrial agreement

•  the trust deed or governing rules of a super fund

•  a federal, state or territory law

• Contributions you make that are not reportable employer superannuation 
contributions are any compulsory contributions that you must make for your 
employees, e.g. 9% Superannuation Guarantee Contributions

I M P O R TA N T
Because of the RESC requirements, you must set up any employer contributions in 
addition to the 9% Superannuation Guarantee as additional employer contributions (EA - 
Employer Additional). Example: If you pay your employees 10$ Superannuation 
Guarantee, you must set up one contribution (with the Type set to SG) for 9% and as 
well as a contribution of 1% (with the Type set to EA). This second contribution would 
also have the option RESC selected.

Field Description

Percentage Rate
If the contribution is calculated on a 
precentage, enter the rate in this field. If the 
rate varies, leave this field as zero.

Amount
If the contribution is a pre-set amount, enter 
the value in this field. If it varies, leave this 
field as zero.

Name
Enter the name of the Provider this 
Superannuation Guarantee Contribution 
relates to.

Superannuation Provider From the dropdown list, select the Provider 
this superannuation contributions relate to.

Cost Centre

If you want to cost this superannuation 
contribution to a specific Cost Centre, enter 
the Cost Centre here. If the Cost Center will 
vary depending on the employee, leave this 
field blank.
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Unit 6—Superannuation Contributions
7 Click on the Liabilities button.

8 Select the pay items this Superannuation Contribution is liable for.

I M P O R TA N T
Superannuation Guarantee contributions are not liable for Superannuation.

9 Click on the Exit button.

10 Click on the Save button or press F10.
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Employee Salary Sacrifice Contributions

To set up Employee Salary Sacrifice Contribution

1 From the Maintanance menu, click on Superannuations.

2 A screen will appear that usually lists your Superannuation calculations. Click 
on the Add button or press F4.

3 From the Superannuation Type dropdown list, select Employee 
Superannuation.

4 In the Code field, enter the number that you want to assign to this Employer 

Contribution. Press .

5 Enter the following information:

Field Description

Contribution Type From the dropdown list, select SS - Salary 
Sacrifice.

Calculation Method From the dropdown list, select how the 
superannuation contribution is calculated.
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Unit 6—Superannuation Contributions
6 Select the option RESC if the contribution is a Reportable Employer 
Superannuation Contribution.

7 Click on the Liabilities button.

8 Select the pay items this superannuation contribution is not liable for.

9 Click on the Exit button.

10 Click on the Save button or press F10.

Field Description

Percentage Rate
If the contribution is calculated on a 
precentage, enter the rate in this field. If the 
rate varies, leave this field as zero.

Amount
If the contribution is a pre-set amount, enter 
the value in this field. If it varies, leave this 
field as zero.

Name Enter the name of the Provider this 
superannuation contribution relates to.

Superannuation Provider From the dropdown list, select the Provider 
this superannuation contributions relate to.

Cost Centre

If you want to cost this superannuation 
contribution to a specific Cost Centre, enter 
the Cost Centre here. If the Cost Center will 
vary depending on the employee, leave this 
field blank.
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Employee Superannuation Contributions

To set up an Employee Superannuation Contribution

1 From the Maintenance menu, click on Superannuations.

2 A screen will appear that usually lists your existing Superannuation 
Calculations. Click on the Add button or press F4.

3 From the Superannuation Type dropdown list, select Employee 
Superannuation.

4 In the Code field, enter the number that you want to assign to this Employer 

Contribution. Press .

5 Enter the following information:

Field Description

Contribution Type From the dropdown list, select MR - Member 
Regular.

Calculation Method From the dropdown list, select how the 
superannuation contribution is calculated.
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Unit 6—Superannuation Contributions
6 Select the option RESC if the contribution is a Reportable Employer 
Superannuation Contribution.

7 Click on the Save button or press F10.

Field Description

Percentage Rate
If the contribution is calculated on a 
precentage, enter the rate in this field. If the 
rate varies, leave this field as zero.

Amount
If the contribution is a pre-set amount, enter 
the value in this field. If it varies, leave this 
field as zero.

Name Enter the name of the Provider this 
superannuation contribution relates to.

Superannuation Provider From the dropdown list, select the Provider 
this superannuation contributions relate to.

Cost Centre

If you want to cost this superannuation 
contribution to a specific Cost Centre, enter 
the Cost Centre here. If the Cost Center will 
vary depending on the employee, leave this 
field blank.
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Editing or Deleting Contributions

To edit an existing Superannuation Contribution

1 From the Maintenance menu, click on Superannuations.

2 From the list of Superannuation Calculations, select the Superannuation 
Contribution you want to edit and click on the Select button.

3 Make the required changes.

4 Click on the Save button or press F10.

To delete an existing Superannuation Contribution.

1 From the Maintenance menu, click on Superannuations.

2 From the list of Superannuation Calculations, select the Superannuation 
Contribution you want to delete and click on the Select button.

3 Click on the Delete button or press F6. A message will appear, confirming 
that you want to delete this Superannuation. Click on Yes.

I M P O R TA N T
If this Superannuation Contribution has been used or is assigned to an employee, it 
cannot be deleted from the system.
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Skills checklist

Tick the skills that you have learned in this unit.

Skills

Set up a new Superannuation Provider

Set up an employer contribution

Set up an employee salary sacrifice contribution

Set up an employee after-tax contribution

Edit an existing superannuation contribution

Delete an existing superannuation contribution
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Deductions
In this unit, you will learn 

how to set up Deductions.
By the end of this unit, you will be able to:

Set up Deductions

Edit existing Deductions
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Overview

Deductions are used to deduct money from the employee’s pay for various items, 
such as Child Support, additional Tax payments and loans or repayments.
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Setting up Deductions

To add a new Deduction

1 From the Maintenance menu, click on Deductions

2 A picklist will be displayed. Normally this list will show all the Deductions you 
have set up. Click on the Add button or press F4.

3 In the Code field, enter a number that you want to use to identify this 

Deduction. Press .

4 Enter a Name for the Deduction.

5 Select the option Post-Tax for the Deduction to be taken out after tax.

6 From the dropdown list, select the Calculation Method used for this 
Deduction. Refer to the following table for when each method is used:

Calculation Method Description

Fixed Dollar Amount Use this option if a pre-determined amount is 
to be deducted from the employee’s pay.

% of Gross Pay Use this option if the amount deducted is a 
percentage of the employee’s gross pay.
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7 Enter the Amount or Percentage Rage for this deduction. If the amount or 
rate varies, leave this field as zero.

8 If you are setting up a Child Support Deduction, set the Type to Child 
Support. If you are setting up a deduction of extra tax, set the Type to PAYG. 
For all other deductions set the Type to Normal.

9 If this Deduction should be costed to a specific Cost Centre, enter the 
appropriate Code in the Cost Centre Code field. Leave this field as 0 to use 
the employee’s default Cost Centre or to specify a Cost Centre specific to the 
employee.

T I P

You can click on the  button to display a list of Cost Centre Codes available. 

10 From the Payment Summary Type dropdown list, select the appropriate 
type. Refer to the following table for the available options:

11 If the Payment Summary Type is set to Deductions, the option 
Union/Professional association fees becomes available. Select this option if 
the deduction represents fees for a union or professional association. By 
selecting this option, these deductions will be reported in the EMPDUPE file 
correctly.

Reducing Balance

Use this option if the employee has a balance 
to pay and a pre-determined amount should 
be deducted each pay, until the balance is 
cleared.

Payment Summary Type Description

None
Select this option for Deductions that are not 
required to appear on the PAYG Payment 
Summary.

Deductions
Select this type for Deductions that are 
required to appear on the PAYG Payment 
Summary, e.g. Union Fees.

Workplace Givings

Select this type for Deductions that are salary 
sacrifice deductions for charity donations.
Note: Only deductions greater than $2 are 
tax deductible.
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NOTE

If the money deducted from multiple employees with this deduction is paid into the 
same bank account, you can use the Pay Deduction by Consolidated Direct Credit 
option. By using this option, the system will total all the instances of this Deduction in 
the pay and add the total in your direct credit transfer (*.ABA) file.

12 Click on the Save button or press F10.
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Editing an existing Deduction

1 From the Maintenance menu, click on Deduction.

2 A picklist will be displayed. Normally this list will show all the Deductions you 
have set up. Select the Deduction you want to edit and click on the Select 
button.

3 Make the required changes.

4 Click on the Save button or press F10.

NOTE

You can also add the Deduction to a group of employees by clicking on the Load button.
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Deleting a Deduction

1 From the Maintenance menu, click on Deduction.

2 A picklist will be displayed. Normally this list will show all the Deductions you 
have set up. Select the Deduction you want to delete and click on the Select 
button.

3 Click on the Delete button or press F6. A message will appear, confirming 
that you want to delete this deduction. Click on Yes.

NOTE

Once a Deduction has been used, you cannot delete it from the system.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Set up a standard Deduction

Edit an existing Deduction

Delete a Deduction
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Leave Groups
In this unit, you will learn 

how to set up rules to 

govern your employees’ 

leave entitlements
By the end of this unit, you will be able to:

Set up Annual Leave Groups

Setup up Long Service Leave Groups

Set up Personal Leave Groups
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Overview

Groups are used to set up the rules that the system will use to accrue annual, long 
service and personal leave.



Unit 8—Leave Groups
Annual Leave Groups

Rules must be set up in order for the system to correctly accrue employees’ Annual 
Leave.

Because leave will be accrued on actual hours (pro-rata), you do not need to set up 
a different set of rules for each set of different hours your employees work.

Example
Some employees work a 38.00 hour week, others work a 37.50 hour week.

In this example you only need to set rules up to deal with the employees that work 
38.00 hours per week. You can assign this rule also to the employees that work 
37.50 hours per week and the system will correctly accrue their leave.

Annual Leave is calculated using the following formula:

To set up Annual Leave Groups

1 From the Maintenance menu, click on Groups, followed by Annual Leave 
Groups.

2 In the Group Code field, enter a code for this group. Press .

3 In the Description field, enter a brief description or title for this group.

HoursLiable( )
FullTimeHoursPerYear( )
-------------------------------------------------------------------- AnnualEntitlement×
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4 If employees on this group are eligible for Leave Loading, enter the 
percentage rate at which it should be calculated in the Leave Loading % 
field.

5 From the Annual Leave Method, click on Hours.

6 Select the option Cap Accruals option if employees on this group are not 
allowed to accrue leave on hours in excess of their standard hours per pay 
period.

7 In the Full Time Hours Per Year field, enter the total number of hours the 
employee works per year. The system will use this information to calculate the 
pro-rata portion of the year the employee has worked.

8 Under the Annual Entitlement Hours field, enter the hours an employee is 
entitled to every year.

9 For Change 1, enter the period when the change will take place in the 
Months after start date field. In the Annual Entitlement Hours field, enter 
the hours the employee will be entitled to after the change takes place.

10 For a further change, enter the period when the change will take place in the 
Months after start date field for Change 2. In the Annual Entitlement Hours 
field, enter the hours the employee will be entitled to after the change takes 
place.

I M P O R TA N T
Because the system will accrue the Annual Leave based on actual hours, it is important 
that the annual leave entitlement you set up here is what the employee will receive if 
they work the full year.

Click on the Save button or press F10.
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Long Service Leave Groups

Rules must be set up in order for the system to correctly accrue employees’ Long 
Service Leave.

Because leave will be accrued on actual hours (pro-rata), you do not need to set up 
a different set of rules for each set of different hours your employees work.

Example
Some employees work a 38.00 hour week, others work a 37.50 hour week.

In this example you only need to set rules up to deal with the employees that work 
38.00 hours per week. You can assign this rule also to the employees that work 
37.50 hours per week and the system will correctly accrue their leave.

Long Service Leave is calculated using the following formula:

To set up Long Service Leave Groups

1 From the Maintenance menu, click on Groups, followed by Long Service 
Leave Groups.

2 Click on the Add button or press F4.

3 In the Group Code field, enter a code for this group. Press .

4 In the Name field, enter a title for this group.

HoursLiable( )
FullTimeHoursPerYear YearsInAccrualPeriod×( )
--------------------------------------------------------------------------------------------------------------------------------------- Entitlement×
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5 From the Method dropdown list, select Hours. In the Full Time Hours Per 
Year field, enter the total number of hours the employee works per year. The 
system will use this information to calculate the pro-rata portion of the year 
the employee has worked.

6 Select the option Cap Accruals option if employees on this group are not 
allowed to accrue leave on hours in excess of their standard hours per pay 
period

7 Click on the Add button.

8 In the Months after start date field, enter the number of months from the 
employee’s start date they will receive this entitlement.

9 In the Number of Hours field, enter the hours the employee will be entitled 
to. This system will use this to calculate the employee’s pro-rata accrual.

10 Click on the Save button or press F10.

11 Repeat Steps 5 through 8 for each entitlement the employee will receive.

NOTE

The Number of Hours is non-cumulative. Each Entitlement is in addition to the previous 
entitlement.

12 Click on the Save button or press F10.

I M P O R TA N T
Once a Long Service Leave Group is assigned to an employee, you can no longer make any 
changes to the group. Make sure that the rules in the group are correct before you 
assign the group to any employees.
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Personal Leave Groups

Rules must be set up in order for the system to correctly accrue employees’ 
Personal Leave.

Because leave will be accrued on actual hours (pro-rata), you do not need to set up 
a different set of rules for each set of different hours your employees work.

Example
Some employees work a 38.00 hour week, others work a 37.50 hour week.

In this example you only need to set rules up to deal with the employees that work 
38.00 hours per week. You can assign this rule also to the employees that work 
37.50 hours per week and the system will correctly accrue their leave.

To set up Personal Leave Groups

1 From the Maintenance menu, click on Groups, followed by Personal Leave 
Groups.

2 In the Group Code field, enter a code for this group. Press .

3 In the Group Description field, enter a brief description or title for this 
group.

4 Select the option Cap Accruals option if employees on this group are not 
allowed to accrue leave on hours in excess of their standard hours per pay 
period.

HoursLiable( )
FullTimeHoursPerYear( )
-------------------------------------------------------------------- AnnualEntitlement×
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5 From the Method dropdown list, select Hours. In the Full Time Hours Per 
Year field, enter the total number of hours the employee works per year. The 
system will use this information to calculate the pro-rata portion of the year 
the employee has worked.

6 For Change 1, enter the period when the change will take place in the 
Months after start date field. In the Hours Entitlement field, enter the hours 
the employee will be entitled to after the change takes place. The system will 
use this information to calculate the employee’s pro-rata entitlement.

7 For a second change takes place, enter the period when the change will take 
place in the Months after start date field for Change 2. In the Hours 
Entitlement field, enter the hours the time employee will be entitled to after 
the change takes place. The system will use this information to calculate the 
employee’s pro-rata entitlement.

8 For a third change takes place, enter the period when the change will take 
place in the Months after start date field for Change 3. In the Hours 
Entitlement field, enter the hours employee will be entitled to after the 
change takes place. The system will use this information to calculate the 
employee’s pro-rata entitlement.

9 In the Repeat final change every dropdown list, select how often the system 
should repeat the final change.

10 Click on the Save button or press F10.

I M P O R TA N T
Once a Personal Leave Group is assigned to employees, you cannot make changes to the 
group.
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Skills checklist

Tick the skills that you have learned in this unit.

Skills

Set up Annual Leave Groups

Set up Long Service Leave Groups

Set up Personal Leave Groups
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In this unit, you will learn 

how to set up new 

employees and edit 

existing employee 

records.
By the end of this unit, you will be able to:

Set up a new employee

Edit an existing employee record
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Overview

This section details the steps and areas that need to be completed when setting up 
a new employee.

The Employee Maintenance is divided into the following 6 sections:

Employee Details

This section contains the employee’s personal details and tax classification.

Leave Entitlements

This section contains the employee’s entitlements to Annual Leave, Personal Leave 
and Long Service Leave.

Other

This section contains the employee’s e-mail address, Rostered Days Off 
entitlements (if applicable) and other options relating to how this employee’s 
payroll information is entered.

User Defined

This section contains a number of user definable fields to store additional employee 
information.

Notes

This section contains all the employee’s payment history notes.

Standard Pay

This section contains the employee’s pay template of what they are normally paid 
per pay period.
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To Add a new Employee

1 From the File menu, select New Employee.

2 The Enter New Employee Code field will automatically display the highest 
available employee number. Override this number if you want to assign a 
different number to the employee.

3 Click on the Add Employee button to add the employee to the system.

NOTE

When adding a new employee, you do not have to save after completing each section. 
You can save once you have completed the employee’s setup.

To Edit an existing Employee

1 From the File menu, select Open Employee.

2 In the Enter Employee Code or Alpha Code field, enter either the employee 
code or their alpha code.

T I P

You can also find the employee by clicking on the Find button or pressing F9. You can 
also change the order from Code to Alpha Code by clicking on the Change Sort Order  
button, using F3 or by clicking on the column headings.

3 Press the  button, click on the Find button or press F9 to load the 
employee’s details.
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Employee Details

To enter an employee’s personal details:

Click on the Employee Details tab if this screen is not active.

1 Enter the following Details:

Field Description

Surname, First Names Enter the employee’s Name in these fields.

Alpha Code

This code is used as the employee’s Alpha 
Sort and is typically the first 8 characters of 
their surname.
Note: The Alpha Code must be unique.

Start Date Enter the employee’s date of employment.

Cost Centre
Enter the employee’s Default Cost Centre. 
Click on the  button to get a list of your 
Costs Centres.

Department
Enter the employee’s Department. Click on 
the  button to get a list of your 
Departments.

Pay Frequency

From the dropdown list, select the 
employee’s pay frequency.
Note: If the employee is a Casual, no 
frequency is required.
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Address Details
Enter the employee’s address details.
Note: Only complete the Country field if the 
employee resides outside Australia.

Telephone Enter a contact number for the employee.

Occupation Enter the employee’s occupation or job title.

Apprentice
Select this option if the employee is an 
Apprenctice. Click on the Apprentice button 
to enter the details of their apprenticeship.

TFN If this record is for an Employee, enter the 
employee’s Tax File Number.

ABN If this record is for a Contractor, enter the 
contactors’ Australian Business Number

Tax Classification Select the appropriate Tax Classification from 
the available options.

Earnings are Not Liable for 
Payroll Tax

Select this option if this employee’s earnings 
are not liable for payroll tax paid by the 
company.

WorkCover
To use the default WorkCover rate to 
calculate your WorkCover payments, select 
the option Use WorkCover rate.

Male/Female Select the employee’s Gender.

Salary/Wage

Specify if the employee is Waged (paid an 
hourly rate) or Salaried (paid a fixed dollar 
amount). For a Salaried employee, also select 
the option Allow Overtime if the employee 
is paid for overtime hours.

Hours per Pay Period Enter the standard number of hours the 
employee is paid.

Full-Time/Part-Time/Contractor Select the employee’s Hours of employment.

Trade Labour Content
If this record is for a Contractor, enter the 
percentage at which the their payroll tax is 
calculated.

Permanent/Casual/Temporary Select the employee’s Term of employment.

Birth Date Enter the employee’s date of birth.

Due Back Date Leave this field blank.

Annual Review Enter the date of this employee’s next annual 
review. This is an optional field.
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Leave Entitlements

Click on the Leave Entitlements tab if this screen is not active.

T I P

To view a breakdown of the employee’s leave balances, click on the Edit button under 
the Other Details section for the respective leave type.

Annual Leave

To set up an employee’s Annual Leave entitlements

1 In the Group field, assign the appropriate Annual Leave Group.

2 The following screen will appear:

3 Select the option From the employee’s start date.

4 Click on the Ok button.
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5 The Entitlement Units field shows how much leave the employee will accrue 
each year, based on the rules you’ve specified in the Annual Leave Group.

6 The Balance field shows the employee’s total entitlement to Annual Leave.

7 The Cost Centre field records the Cost Centre to which the employee’s 
Annual Leave Paid will be costed. 

Personal Leave

To enter an employee’s Personal Leave entitlements

1 In the Group field, assign the appropriate Personal Leave Group. 

2 The following screen will appear:

3 Select the option From the employee’s start date.

4 Click on the Ok button.

5 The Entitlement Units field shows how much leave the employee will accrue 
each year, based on the rules you’ve specified in the Personal Leave Group.

6 The Balance field shows the employee’s total entitlement to Personal Leave.

7 The Cost Centre field records the Cost Centre to which the employee’s 
Personal Leave will be costed. 

Long Service Leave

To enter an employee’s Long Service Leave entitlements

1 In the Group field, assign the appropriate Long Service Leave Group.
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2 The following screen will appear:

3 Select the option From the employee’s start date.

4 Click on the Ok button.

5 The Entitlement Units field shows how much leave the employee will accrue 
each year, based on the rules you’ve specified in the Long Service Leave 
Group.

6 The Balance field shows the employee’s total entitlement to Long Service 
Leave.

7 The Cost Centre field records the Cost Centre to which the employee’s Long 
Service Leave Paid will be costed. 

Other options
If the option Leave Loading is selected in the employee’s Tax Classification, the 
Leave Loading % field will show the percentage at which Leave Loading will be 
calculated, based on the percentage entered in the Annual Leave Group assigned 
to the employee.

Select the option Claim leave loading tax-free threshold if the employee is 
entitled to Leave Loading and is claiming the tax-free threshold for Leave Loading.

The Days of sick leave without a medical certificate field shows the number of 
days Sick Leave the employee has had in their current entitlement year without 
providing a medical certificate.
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Other

Click on the Other tab if this screen is not active.

Email
You can record e-mail addresses for your employees. If you are going to e-mail 
payslips to your employees, you must complete the following fields:

1 In the Email address field, enter the e-mail address where the employee’s 
payslip should be sent.

2 In the Password field, enter the password with which their payslip will be 
encrypted.

T I P

If you have purchased EXO MyStaffInfo, the employee’s e-mail address and password 
will be their login for the MyStaffInfo website.
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Rostered Days Off

To set up an employee’s Rostered Days Off

1 Click on the Rostered Days Off button.

2 Click on the option Track RDO’s for this employee.

3 Enter the following Details:

Public Holiday Lieu Days/Hours
This field is used for recording time in lieu the employee accrued for working on 
public holidays or for working additional hours.

Pay rounding carried foward
If you have set up the system to apply rounding to an employee’s pays, each time 
an employee’s net pay is rounded, the system will accumulate the rounded-off 
cents in this field. Once the minimum payout value is reached, this accumulated 
value will be autmatically be paid to the employee in their next pay.

Field Description

Total RDO hours available This field displays the employee’s accrued 
RDO’s. 

RDO Rate (per hour) Enter the rate at which the employee accrues 
RDO’s.

Do not accrue on hours more 
than (per pay period)

Enter the maximum number of hours the 
employee accrues RDO’s on per pay period.

Standard Hours per Day Enter the employee’s standard working hours 
per day.
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Rapid Employee
If you are using Rapid Load Pay and will enter this employee’s pay using Rapid 
Load Pay, select this option.

Time and Attendance Employee
If you have EXO Time and Attendance and will record the employee’s time and 
attendance information using EXO Time and Attendance, select this option.
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User Defined

Click on the User Defined tab, if it is not currently active.

User Defined Fields
This area contains user definable fields that can be used to record additional 
information on your employees.

To rename a User Defined Field

1 Double-click on the User Defined caption of the field you want to use.

2 Enter a title for this field.

3 Press Enter.

To reset the User Defined Field

1 Double-click on the title of the field.

2 Delete the title.

3 Press Enter.
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4 The following user definable fields are available:

Field Description

2 x Check boxes Used for yes/no options.

2 x Dates Used to record a date.

3 x Text Fields Used to enter short text descriptions.

1 x Number Field Used to enter a value.

1 x Comment Field Used to enter comments.
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Notes

Click on the Notes tab if this screen is not active.

This screen shows all the notes that have been entered against an employee. 

Every time an employee is paid leave, their leave entitlements are changed or their 
Hourly Rate/Salary is altered, the system automatically generates a note, which is 
stored in this area.

To Edit an exiting Note:

1 Double-click on the note you want to edit.
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To Add a new Note:

1 Click on the Add button or press F4.

2 Enter the following details:

3 In the space provided, enter your note.

4 Click on the Save button or press F10 to save the note.

Field Description

Date This is the date on which the note is added.

User This field default to the User Code of the user 
adding this note.

Note Type From the dropdown list, select the type of 
note you are adding.

Reminder Date
If you want the system to remind you of this 
note, enter the date on which you want to be 
reminded.

Recipients Click on the  button to select the Users 
that should be reminded.
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Standard Pay

Click on the Standard Pay tab if this screen is not active.

This area stores the employee’s pay template; what they are normally paid each 
pay period.

I M P O R TA N T
If changes are made to the employee’s Standard Pay after a Current or One-Off Pay is 
created, the pay will not automatically be updated with the changes. 

Hourly Rate

To enter an Hourly Rate

1 Click on the Hourly Rates button.
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2 Enter the employees Hourly Rate. If you have the option for Multiple Wage 
Hourly Rates turned on, you will be able to enter up to 9 Hourly Rates for 
each employee.

NOTE

You can change the description(s) of the Hourly Rate(s) from the Hourly Rates. Refer 
to your EXO Payroll user guide for more information.

3 Click on the Save  button or press F10.

Wages

To add Standard Pay Wages

1 Click on the Wages button.

2 In the line corresponding with Ordinary, enter the standard hours the 
employee is paid in each pay period.

NOTE

If there are no lines in the employee’s Wages screen, click on the Add button or press 
F4 to add a new line.
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3 Alternatively, you can click on the corresponding line and click on Edit or 
press F5.

4 From the Wage Rate Type field, select Ordinary.

5 The Hourly Rate field shows the rate at which hours against this pay rate 
multiplier will be paid.

6 If the employee has multiple hourly rates, enter the appropriate Hourly Rate 
Code in the Hourly Rate Code field.

7 In the Number Hours field, enter the standard number of hours the 
employee is paid in a pay period.

8 If you want to cost there hours to a specific Cost Centre, enter the 
appropirate Cost Centre Code in Cost Centre field.

9 In the Alternative Type Desciption field you can enter an alternative 
description for this pay rate multiplier.

10 Click on the Save button or press F10 to save from this screen.

11 Click on the Save button or press F10 to save the employee’s Standard Pay 
Wages.
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Allowances

To add Standard Pay Allowances

1 Click on the Allowances button.

2 Click on the Add button or press F4.

3 Enter the following information:

Field Description

Code
Enter the code for the Allowance you want to add.
Note: You can click on the Find button or press F9 to get a list of 
your Allowances.

Allowance 
Name

This field displays the name of the Allowance.
Note: If you have selected the option Can Modify Name in the 
Allowance Setup, you can change the name here.
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NOTE

The availability of these fields are determined by the setup of the Allowance.

4 Click on the Save button or press F10.

5 Click on the Save button or press F10 to save the employee’s Standard Pay 
Allowances.

Salary

To add a Standard Pay Salary

1 Click on the Salary button.

2 Enter the employee’s Annual Salary. The system will automatically calculate 
the Salary per pay period and the Hourly Rate.

Units Enter the number of Units to pay against this Allowance.

Rate Enter the rate at which the Units should be paid.

Amount Enter the Amount of this Allowance.

Rate Type Enter the Pay Rate Multiplier used for this Allowance.

Periods to Tax 
Over

If the Allowance Type is set to Bonus, enter the number of periods 
the Bonus should be taxed over.
Note: You would normally only enter a value in this field when you 
pay this Allowance to the employee in the Current Pay.

Wage Rate 
Code

Enter the Wage Rate Code of the Hourly Rate at which this 
Allowance should be paid.

Cost Centre Enter the Cost Centre to which this Allowance should be costed.
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NOTE

Once the salary per pay period is calculated, the system may adjust the Annual Salary 
to reflect the actual annual value paid to the employee.

3 Click on the Save button or press F10 to save the employee’s Standard Pay 
Salary.

Deductions

To add Standard Pay Deductions

1 Click on the Deductions button.
© MYOB Technology Pty Ltd 2009. This document may not be copied or utilised in any way without permission from the publisher.

 85



MYOB EXO Payroll Administration MYOB EXO Payroll

 8
2 Click on the Add button or press F4.

3 Enter the following information:

Field Description

Deduction Code

Enter the code of the Deduction you want to 
add.
Note: You can also click on the Find button or 
press F9 to get a list of your Deductions.

Rate Enter the Rate at which this Deduction is 
made.

Amount Enter the Amount of this Deduction.

Reducing Balance
If the Deduction Type is set to Reducing 
Balance, enter the remaining balance of this 
Deduction.

Protected Earnings 
Amount

If the Deduction Type is set to Child Support, 
this field will show the protected earnings.

Cost Centre

This field will default to the employee’s Default 
Cost Centre. To have the deduction costed to 
a specific Cost Centre, enter the appropriate 
code in this field.

BSB Number, Account Enter the bank account details for this 
Deduction.

Reference Enter the Reference for the bank account.
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NOTE

The availability of these fields are determined by the setup of the Deduction.

4 Click on the Save button or press F10.

5 Click on the Save button or press F10 to save the employee’s Standard Pay 
Deductions.

Superannuation

To add Standard Pay Superannuation Contributions

1 Click on the Superannuation button.

2 Click on the Add button or press F4.
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3 A list of your Superannuation Calculations will appear. Double-click on the 
Contribution you want to add.

4 In the Percentage Rate field, enter the rate at which the superannuation 
should be calculated.

5 In the Amount field, enter the amount of the superannuation contribution.

6 In the Fund Number field, enter the employee’s superannuation fund 
membership number.

7 In the Cost Centre field, enter the Costs Centre this Superannuation 
Contribution should be costed to.

8 Click on the Save button or press F10.

NOTE

The availability of these fields are determined by the setup of the Superannuation 
Contribution.

9 Click on the Exit button or press Esc to return to the employee’s Standard 
Pay.
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How Paid

To set up Standard Pay Payment Methods

1 Click on the How Paid  button.

To set up Standard Pay Direct Credit information

1 Click on the Yes option for Direct Credit.

2 Click on the Add/Edit Direct Credits button.
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3 Click on the Add button or press F4.

4 Enter the following information:

5 Click on the Save button or press F10.

6 Click on the Save button or press F10 to return to the employee’s How Paid.

To set up Standard Pay Cash Payment information

1 Click on the Yes option to pay a fixed amount in cash. 

2 Enter the amount in the Cash Amount field.

3 Click on the Balance option to pay the balance of the employee’s pay in 
Cash.

Field Description

BSB Number, Account Enter the employee’s bank account.

Reference Enter the reference that should appear on the 
employee’s bank statement.

Priority Set the priority order for this bank transfer.

Fixed Dollar Amount, 
Pay Balance of Pay,
Allow Part Payment

Select the type of transfer for this account. Use Fixed 
Dollar Amount for a set amount that has to be 
transfered every pay.
Use Allow Part Payment for transfers if there is 
sufficient funds.
Use Pay Balance of Pay for any remaining money to 
be transfered.
Note: At leasts one of the bank acocunts must be set to 
Pay Balance of Pay.

Required Amount Enter the amount to be transfered to bank accounts set 
to Fixed Dollar Amount or Allow Part Payment.
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To set up Standard Pay Cheque Payment information

1 Click on the Yes option to pay a fixed amount in cash. 

2 Enter the amount in the Cheque Amount field.

3 Click on the Balance option to pay the balance of the employee’s pay by 
cheque.

NOTE

If you make any payments by Cash, the Cash Analysis area will show you the breakdown 
of denominations required to pay the employee.

NOTE

If you are applying any rounding to the employee’s Net Pay, the Rounding field will show 
the value that is rounded from the employee’s Net Pay.

Hours Paid

To set up Standard Pay Hours Paid for a Salaried Employee

1 Click on the Hours Paid button.

2 In the The total number of hours paid field, enter the employee’s standard 
number of hours paid.

I M P O R TA N T
The value you enter in this field must be equal to the number of hours entered in the 
Hours per Pay Period field in the Employee Details screen.

3 Click on the Save button or press F10 to save the employee’s Standard Pay 
Hours Paid.
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Click on the Save button or press F10 to save the employee’s Standard Pay 
Payment Setup.

Default Payslip Note

To add a Standard Pay Default Payslip Note

1 Click on the Default Payslip Note button.

2 In the space provided enter the default note to appear on the employee’s 
payslip.

NOTE

This default note can be changed when processing a pay. Any changes to this note will 
only be applicable to that pay.

3 Click on the Save button or press F10 to save the employee’s Default Payslip 
Note.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Add a new employee

Set up Leave Entitlements

Set up Rostered Days Off Entitlements

Record employee’s e-mail address

Add an employee note

Set up the employee’s Standard Pay information
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Overview

You will most likely change to EXO Payroll during the tax year. In order to provide 
your employees with one PAYG Payment Summary for the entire Tax Year, you 
need to load their earnings and PAYG withheld into the system. 

You may decide to also load the balance of superannuation contributions made to 
each employee's superannuation fund. 

You also need to load employee’s leave balances into the system.

Before you begin

As you will be entering dollar amounts/hours in the system, you must ensure that 
all the pay items (Allowances, Deductions, Superannuation Contributions, etc.) for 
which you are loading values have their Calculation Method set to Fixed Dollar 
Amount.

Once you have completed the year-to-date loading, you must set the Calculation 
Method back to the original setting.

If you have any employees that terminated in the current financial year, you must 
re-instate them before you can load their year-to-date information.

To reinstate an employee

1 From the File menu, select Open Employee.

2 Click on the Find button or press F9.

3 Select the option Show Terminated Employees to show terminated 
employees.
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4 Double-click on the terminated employee you want to reinstate.

5 Make a note of the employees Terminated date.

6 Click on the Reinstate button.

7 In the Re-instate Date field, enter the employee’s original Start Date.

I M P O R TA N T
When reinstating an employee, you must enter the employee’s original start date. Doing 
so will ensure that the correct information will be reported to the ATO.

8 Click on the Reinstate button.

9 A message will be displayed, asking your to confirm that you want to 
reinstate this employee. Click on Yes.

10 Another message will appear, reminding you to edit the employee and 
update their leave entitlements. Click on Ok.
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Entering Year-To-Date pay information

Create a One-Off Pay

1 From the Pay menu, click on One-Off Pay.

2 From the Pay Frequency dropdown list, click on the appropriate pay 
frequency.

3 In the Pay Period End Date field, enter the pay period end date of the last 
pay in your previous payroll system.

4 In the Physical Pay Date field, enter physical pay date of the last pay in your 
previous payroll system.

T I P

When loading year-to-date information, enter information up to your last pay for the 
previous month. Process any pays in the current month as parallel pay. This will provide 
you with an accurate month-to-date report for the current month.

5 From the Copy Standard Pay dropdown list, click on No.

6 Click on Create One-Off Pay.

7 Click on No.

8 Click on Ok.

9 Click on the Calculate Pay button.

10 In the Enter Employee Code or Alpha Code field, enter the Code or Alpha 
Code for the employee and press .

Enter Gross Wages/Salary

1 Click on the Allowances button.

2 Click on the Add button or press F4.

3 Double-click on Allowance 999 YTD Gross.

4 In the Amount field, enter the emplyees year-to-date gross Wages/Salary. 
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I M P O R TA N T
The gross Wages/Salary entered must exclude any allowances, but include any pre-tax 
(salary sacrifice) Deductions.

5 Click on Save or press F10.

To load Allowances shown separately

1 Click on the Allowances button.

2 Click on the Add button or press F4.

3 Click on the Find button or press F9 to get a list of your Allowances.

4 Double-click on the Allowance you need to load totals for.

5 In the relevant field(s), enter the appropriate values.

6 Click on the Save button or press F10.

To load Deductions

1 Click on the Deductions button.

2 Click on the Add button or press F4.

3 Click on the Find button or press F9 to get a list of your Deductions.

4 Double-click on the Deduction you need to load totals for.

5 In the relevant field(s), enter the appropriate values.

6 Click on the Save button or press F10.

To load Superannuation

1 Click on the Superannuations button.

2 Click on the Add button or press F4.

3 Double-click on the Superannuation Contribution you need to load totals for.

4 In the Amount field, enter the year-to-date total.

5 Click on the Save button or press F10.
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To load PAYG

1 Click on the PAYG button.

2 Select the option Override PAYG. 

3 Enter the year-to-date PAYG withheld. If the employee has a HELP repayment, 
include this in the PAYG value (if applicable/available).

4 Enter the HELP component of the PAYG withheld in the HELP field (if 
applicable/available).

If the employee was terminated, you must re-terminate them again:

1 Click on the Termination Wizard button.

2 A message will appear, asking you to confirm that you want to terminate this 
employee. Click on Yes. 

3 The Termination Wizard will be activated. This wizard will step you through 
paying out the employee’s leave owed on termination.

4 In the Termination Date field, enter the employee’s original date of 
termination.

5 In the Terminated by field, enter the name of the person that processed the 
original termination pay.

6 From the Reason for termination dropdown list, select the original reason 
for the employee’s termination.

7 Ensure that the Total Annual Leave Hours Entitlement is 0.00.

8 Click on the Next button or press F8.

9 Ensure that the Number of Long Service Leave hours to pay is 0.00.

10 Click on the Next button or press F8.

11 Click on the Finish button or press F10.

Once you have completed the year-to-date loading for this employee, click on the 
Save button or press F10 to save this pay and return to the One-Off Pay screen.

Repeat these steps to load year-to-date information for all your employees.
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Finalising the One-Off Pay

1 Click on the Print Reports button to print the Pay Sheet report, and check 
the figures you have entered.

2 From the Pay tab, double-click on the Pay Summary report.

3 From Sort Order 1 select Employee Code or Employee Alpha.

4 Click on the Report Options button.

5 Select the following options:

6 Ensure the option Apply super guarantee scheme is not selected. This will 
ensure that you see all employer contributions you have entered.

7 Click on Save or press F10.

8 From the Destination dropdown list, select Printer. From the Printer 
dropdown list, select the appropriate printer.

9 Click on Print or press F9.

10 If you find any mistakes, correct these mistakes before proceeding.

11 Click on the Finish One-Off Pay, Backup button to complete and update the 
One-Off Pay.

12 A message will appear, asking you confirm that the pay is correct and that all 
reports are printed. Click on Yes.

13 You will be prompted to do a backup. Click on Backup.

14 Once the backup is completed, a message will appear, confirming that the 
pay has successfuly been updated. Click on Ok.

Show Details

Show individual Wages

Show individual Allowances

Show individual Deductions

Show individual Superannuations
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Entering Leave Balances

1 From the File, click on Open Employees.

2 In the Enter Employee Code or Alpha Code field, enter either the employee 
code or their alpha code.

3 Press the  button, click on the Find button or press F9 to load the 
employee’s details.

4 Click on the Leave Entitlements tab.

To enter balances for Annual Leave

1 Click on the Edit button under Other Details to alter the employee’s Balance 
for Annual Leave.
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2 In the Carry Over field, enter the hours of Annual Leave carried over from 
your previous system.

3 Click on the Save button or press F10.

To enter balances for Personal Leave

1 Click on the Edit button under Other Details to alter the employee’s Balance 
for Personal Leave.

2 In the Carry Over field, enter the hours of Personal Leave carried over from 
your previous system.

3 Click on the Save button or press F10.

To enter balances for Long Service Leave

1 Click on the Edit button under Other Details to alter the employee’s Balance 
for Long Service Leave.

2 If the employee has outstanding Long Service Leave accrued prior to 16 
August 1978, enter the hours in the Hours Prior to 16/08/1978 field.

3 If the employee has outstanding Long Service Leave accrued between 16 
August 1978 and 17 August 1993, enter the hours in the Hours between 
16/08/1978 and 17/08/1993 field.
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4 If the employee has outstanding Long Service Leave accrued after 17 August 
1993, enter the hours in the Hours after 17/08/1993 field.

5 The Year-To-Date field will show the employee’s current accrual. 

NOTE

If you want to load the employee’s current Long Service Leave accrual, you must install 
the LOADLSL utility, located on your Employer Services CD. This utility will enable you 
to load the employees Long Service Leave accrual. Refer to the section See “To load 
Long Service Leave Accrual” on page 105 for instructions on entering this value.

6 Click on the Save button or press F10.

To enter balances for Rostered Days Off

1 Click on the Rostered Days Off button.

2 In the Total RDO hours available field, enter the employee’s balance up to 
the last pay.

3 Click on the Save button or press F10.

To enter balances for Lieu Time

1 Click on the Other tab.

2 In the Public Holiday Lieu Hours field, enter the employee’s balance up to 
the last pay.

Click on Save or press F10 to save the changes to this employee’s leave balances.

Repeat these steps to load leave balances for all your current employees.
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To load Long Service Leave Accrual

1 From the Special menu, select Special Applications.

2 Select Load YTD LSL and clicn on Save or press F10.

3 In the Year to Date field, enter the year-to-date accrual for each employee.

4 Click on the Exit button.

5 Click on the Exit button or press Esc.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Load Year-to-Date information

Enter Leave Balances
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Backup Options
In this unit you will learn 

how to set up the system 

backups.
By the end of this unit, you will be able to:

Set up the backup destination

Set up the maximum backup volumes
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Overview

Making regular backups of your system is essential. The system will force you to do 
a backup at certain points, e.g. updating a pay, closing the system, upgrading to 
the latest version.

To make this process as smooth as possible, you need to set up the default options 
the system will use every time a backup is done.

Setting default backup options

1 From the Utilities menu, click on Backup Options.

2 To backup onto a network, flash drive or CD RW, select Hard Disk from the 
Backup Drive dropdown list.

3 The Number of Backup Sets will default to 7. This is the minimum volumes 
the system will allow.

4 Click on the  button to browse for the location where the backups should 
be stored.

5 Select the Automatic Backup on Exit option if you want the system to 
prompt you to do a backup when you exit.

I M P O R TA N T
If you do not select the option Automatic Backup on Exit, the system will not prompt 
you do a backup when you exit and no backup will be done.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Set up the default Backup location
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Backup & Restore
In this unit, you will learn 

how to make a backup of 

your system and how to 

restore from a previous 

backup.
By the end of this unit, you will be able to:

Make a manual backup

Restore from a previous backup
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Overview

The system will prompt you during various processes to complete a backup. 
However, you can make a manual backup at any time. 

If you have more than one MYOB Employer Services product, e.g. EXO Payroll and 
EXO Time and Attendance, you do not need to make a backup in each product. 
Whenever a backup is done, the data from all the products is backed up.

On occasion, you may need to restore from a previous backup. 
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Making a manual backup

To make a backup

1 From the Utilities menu, click on Backup.

2 Click on Backup.

3 The system will proceed with the backup. 

NOTE

The backup files are usually named after the payroll company and consist of a Zip and a 
Log file, followed by the volume number, e.g. Salary.Z1, Salary.L1.  Salary indicates that 
it's the salaries payroll company, Z/L indicates the respective Zip and Log file. 1 
indicates that it is backup set 1.
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To restore from a previous backup

WA R N I N G

When you restore from a previous backup, any changes made in the system since the 
backup was made, regardless of which product they were made in, will be lost. You may 
need to considder alternatives to restoring the data if you do not want to lose any 
changes made since the backup you are about to restore from, was made.

To restore from a backup

1 From the Utilities backup, click on Restore.

2 Click on the Restore button.

NOTE

If the backup you wish to restore is not listed here, click on the option Show other 
company backups. All backups will be displayed, irrespective of the company you are 
currently accessing.

3 Highlight the backup you want to restore and click on the Save button or 
press F10.
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4 A message will appear, asking you to confirm that this is the correct backup 
you want to restore and that you want to proceed with the restore. If this is 
the correct backup, click on the Yes button, otherwise, click on No and 
repeat steps 1 through 4.

5 You may be prompted to enter a User Code and Password. Enter these in 
the appropriate fields and click on the Save button or press F10.

6 A message will appear, confirming that the data has successfully been 
restored. Click on Ok.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Making a manual backup

Restore from a previous backup
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This unit contains a 

number of appendices for 

further study:
Appendix 1: Migrating employee data from 
MYOB Premier/MYOB PowerPay
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Appendix 1: Migrating employee data

If your previous payroll system was MYOB Premier 10 (or later) or MYOB PowerPay 
8.5 (or later), you can migrate your employees’ basic information to EXO Payroll 
using the Migration Wizard available in EXO Payroll.

In order to be migrated using the Migration Wizard, data must be exported from 
the source payroll system in comma-separated format.

To export data from MYOB Premier

1 Select Export Data > Cards > Employees from the File menu. This opens the 
Export File window.

2 Select Comma-separated for the Export File Format.

3 Select Header Record for the First Record.

4 Use the fields on the bottom half of the window to specify which employees 
you want to export.
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5 Click Continue.

6 On the Export Data window, click Match All. 

7 Click Export.

8 Enter a name for the export file.

9 Click Save.

To export data from MYOB PowerPay:

1 Select Export Data... from the File menu. This opens the Export Parameters 
window.

2 Select Employees for the Type of Export.

3 Select Tab Delimited for the Export File Format.

4 Select Header Record for the First Record.

5 Use the fields on the bottom half of the window to specify which employees 
you want to export.
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6 Click Continue.

7 On the Export Employees window, click Match All. 

8 Click Continue.

9 Enter a name for the export file.

10 Click Save.

11 Open the file in Microsoft Excel.

12 Save the file in Comma Separated Values (CSV) format.

To migrate the exported information to EXO Payroll

1 From the Help menu, select Migration Tool. The following window is 
displayed:

2 Click Next on the Welcome screen.
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3 Click Browse to specify the location of the CSV file exported from 
PowerPay/Premier.

4 Click Next.

5 If you are migrating data from MYOB PowerPay, you must map the PowerPay 
Pay Frequencies in the export file to PayrollEnterprise Pay Frequencies. For 
each frequency Code listed, select a Pay Frequency (Weekly, Fortnightly, Bi-
monthly, 4 weekly or Monthly). 

6 Click Next once all Pay Frequencies have been mapped.

7 At this point you must back up your company file before proceeding.

8 Once the backup is completed, the Migration Tool will check that it can read 
the CSV file successfully. 

9 Once the file has passed all the checks, click Next to continue.

10 Select the option I accept full responsibility....

11 Click Migrate to begin the migration operation.

12 The progress of the migration is displayed.

13 Once the migration is complete, the results of the migration are displayed. 
Click Print to print a copy of the migration log. 

NOTE

If any fatal errors were encountered, exit the Migration Tool and correct the problems 
that caused them. 

14 Click Next to continue.

15 Click Finish.

Your employees’ basic information will now migrated to EXO Payroll. You can now 
complete the setup of additional information, e.g. Standard Pay information.
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